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1.0 Admission and Registration  

Introduction 

 

This section will cover the processes involved in admitting and registering children within 
your centre.  If the child is already registered in another centre, then you will need to 
contact that centre and have the child cross-enrolled to your centre.  There are two 
possible scenarios when admitting a child: a child that is in the BCeSIS system 
and one that has never been in the system. 
 

Processes 

1.1 Admitting and Registering a Child 

 
Purpose 
 
Admission is the process of entering a child’s data into BCeSIS and is completed only 
once for each child in their education career.  When a child is admitted, a record is 
created in BCeSIS; a second step of registering the child will usually take place at the 
same time (registration allows the Centre to take attendance for the child).  Registration 
takes place at the beginning of each year. 
 

Overview 
 
Because BCeSIS assigns PENs (Personal Education Numbers) to new children in the 
system every night, and because each child can have only one PEN, a restrictive query 
must take place before a child is admitted.  A restrictive query helps ensure that each 
child receives only one PEN.  A child keeps this PEN throughout their educational 
career.  Unless the child is completely new to StrongStart, there may already be a record 
for the child in BCeSIS and that is the record that MUST be used.   

 
The Admission process has two main steps.  

1. Query the database to determine if the child you wish to admit already has a 
record in the BCeSIS database. 

2. a) Admit a child new to BCeSIS by entering basic demographic information  

OR  

b) Admit a child who has an existing record in BCeSIS by selecting that record 
and updating their information as necessary. 
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1.1.1 Performing a Restrictive Query 

 
Restrictive Query is the name given to the process of searching the database to 
determine if the child record already exists. It’s important to be certain the child you are 
admitting is NOT already in the database.  
The first record entered for a child becomes that child’s permanent record and must be 
maintained so that a complete history for the child is generated.   
 
When a child visits another BCeSIS centre, the access to that record is made available 
through the cross-enrollment process.   
 
If a duplicate record is created, that new record will not receive a PEN, cannot be 
merged with the original record, and cannot be deleted by the centre or district.  The 
district will receive error reports, will have to print all relevant data, request the record be 
deleted, admit the correct original record, and then manually update the original record.   
 
To assist you with the use of the correct process, we will go through the steps of the 
restrictive query and provide some tips on common reasons why records are not found 
and what you should do: 

 
 

Conducting a Restrictive Query on New Children 
 

To protect the privacy of children, restrictions have been placed on how an 
admission query can be conducted in BCeSIS.  For example, you cannot use the 
% wild card and search the entire database.  Furthermore, you can only query 
certain fields (legal last name, gender and birth date).  It is for these reasons that 
that the appellation “Restrictive Query” is used.  A Restrictive Query is the first 
step in admitting a child. 
 
The biggest issue in admitting children is that of duplicate PEN’s.  When 
duplicates are created, a large amount of energy and resources must go into 
rectifying the duplicate as a child can only have one record (the first record acts 
as the child’s de facto permanent record and must be maintained for a complete 
history of the child).  Due diligence in conducting a Restrictive Query when 
admitting a child will help minimize duplicating child records and PEN’s.  Be 
proactive and prevent duplicate records and PEN’s by following the steps 
outlined below. 
 
 

If at any time the query calls up the child, then proceed with the registration.  If 
not, then go to the next number in the list. 
 
1. Enter the child’s legal last name, gender and birth date. 
 
2. Change the gender and search again. 
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3. Check to see if the birthday month, day or year have been transposed.  
 
4. Check the admission form to see if the child has a usual last name different 

from the legal name and try using that (i.e. mother’s maiden name). 
 
5. If the child has a compound last name: try variations using a hyphen, using a 

space, using the hyphen with spaces, without spaces, or using just one of the 
two names in the compound. 

 
6. Check spelling variations such as Smith/Smyth Clark/Clarke. 
 
7. Ask the child/parent if the child was registered under a different name at his 

her previous centre.  If so, try that name. 
 
8. If none of these work, contact should be made with the previous centre (if 

any) prior to creating a new record and determine how the record was 
entered in the previous centre.  It may be that the previous centre has not yet 
processed that student or has entered the child’s data erroneously.  
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1.1.1.1 Conducting a Restrictive Query 

Pathway: Start screen > Admit button 
 
To protect the privacy of children, restrictions have been placed on how an admission query can be conducted in BCeSIS.  For example, you 
cannot use the % wild card and search the entire database.  Furthermore, you can only query certain fields (legal last name, gender and birth 
date).  It is for these reasons that that the appellation “Restrictive Query” is used.  A Restrictive Query is the first step in admitting a child. 
 
   
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Steps: 

1. Enter the child’s legal last name, gender and birth date (DD-MMM-YYYY). 
2. Press the F8 key. 
3. Continue to query until you are certain the child is/isn’t in the system. 
4. If the child is in the system, highlight that child and click on the Select button.  If the child has never been in BCeSIS before, click on the 

Enroll New button. 

BCeSIS will search 40 days on either 
side of the birth date in the event this 
data was input incorrectly.  Also 
consider that a clerk may have 
transposed month and day. 

Query with legal last name, gender, 
and birth date and then press F8. 

An improperly input Gender is the most 
common reason for duplicate PENs.  
Make sure you query both genders to 
ensure the child isn’t in the system 
already. 

Clicking on the More Information 
button will bring up this screen.  Use 
this info to confirm this child is the 
one you are querying for. 

Also, if your query is unsuccessful… 
 

• Check for a different last name (i.e. 
mother’s maiden name). 

• With a compound last name try 
variations using a hyphen, using a 
space, using just one of the two 
names in the compound, etc. 

• Check spelling variations such as 
Smith/Smyth, Clark/Clarke. 

 

Click on Enroll New once you are 
certain that this is a new child to 
BCeSIS. 

Click on the Select button once you have found the child you would like to enroll (admit).  If you can’t find the 
child in the system, but you know the child has previously been in entered into BCeSIS, contact the previous 
centre before proceeding.  
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1.1.2 Enrolling a New Child (no record turns up after a restrictive query) 

Once you have determined that a record does not exist for the child, you would 
then proceed to admit the child as a new record.  You will be asked on the first 
admission screen to check what legal documents were used to verify the child 
information.  Please refer to these legal documents to ensure you have the 
correct information by comparing them to the admission form the 
parent/guardian completed prior to beginning this process. 
 

Note: Most centre users would not have the choice of selecting a different centre but if 
you do, remember to Lock the Centre if you have access to multiple centres/schools. 
This will ensure the child is admitted into the correct centre. 

 

Procedure 

Path: Start screen>Admit 
 

1. Perform the restrictive query. Message at bottom of screen reveals ‘ no 
records retrieved’ 

 

 
 
 

2. Click the Enroll New button on the bottom of the Admit screen. 
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3. Fill in the fields outlined below. The mandatory fields in the Basic Student 
Demographics screen are bolded (ensure that you do not have your caps 
lock on, all information is to be entered in upper and lower case). 

• Current Centre 

• Pupil No—This is a system-generated number and cannot be entered. 

• Legal Last Name 

• Legal First Name 

• Usual Last Name—defaults to legal last name but it can be different 

• Gender 

• Birth Date 

• Proof of Age 

• Reason (for Admission) 

• Date (Admission)—defaults to today’s date 

• Grade—Select from a drop-down list populated by the centre during 
centre set-up. 

• Property Address – important to use Canada Post address conventions 
(refer to Standards manual for BCeSIS for further information).   

• Mailing Address- check the box if same as property address.  If the child’s 
mailing address is different from his/her property address, it should be 
typed in here. 

 There are also non-bolded fields which are mandatory in BC: 

• Legal Middle Name – if none, check box 

• Postal code  

• Previous School (The fields required in this section are dependant on the 
Admission Reason code chosen in the Admission Information section. 
Check Systems Codes>Centre>Admission Codes for definitions) 

 
That’s all that needs to be done to admit a new child into the system but, if you 
have additional information, you can use the appropriate fields in the various 
screens in the demographic loop.  Do not use fields for any information other 
than what they were intended. 
 

4. Save the record.  
 

5. Three separate prompts will display in sequential order;  
1. Release of Information? Yes or No depending on the parents wishes 

and centre policy. 

 
 

2. Would you like to create an Attendance Registration record? Yes or No. 
Always respond with a Yes. 
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3. Do you wish to assign siblings? Yes or No. Choosing Yes will take you 
to the select Student Siblings screen where you will be required to 
perform a restrictive query to select the child’s siblings. This activity will 
link the children and parent’s records so that if one is updated you will 
be prompted to automatically update the others.  

 

  
 
 

PEN Number The Personal Education Number (PEN) number cannot be entered into 

BCeSIS, the field is populated daily.  The system looks for children without a PEN and 

populates the State/Ministry field.  If it doesn’t populate, that means there is already a 

record for that child in the system.  When the PEN number will not populate because 

there is already an existing record with that number in BCeSIS, the district will receive an 

error report.  It is very important to review these reports each week and clean up 

duplicates immediately.  The longer the duplicate record remains, the more information 

will be entered and will need to be printed and manually re-entered when the duplicate 

record is deleted. 

 

Note that there are some fields that will not be used for BC, Ethnicity/Race on the 
Student Basic Demographics screen is one of those.  It is important to remember that 
this is a packaged software product that is also used by other jurisdictions throughout 
the world. BC does not have control over fields and screens that are generic to the base 
product. 

1.1.3 Enrolling a Child with an Existing Record 

You have performed a Restrictive Query for the child and have found that a record exists 
in BCeSIS. Choose the child you wish to admit by clicking the Select button.  
 
It is possible, that the query would reveal more than one child that matches the search 
criteria. It is important to ensure that you are selecting the correct record. The More 
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Information button will reveal additional information such as parents’ names, to assist 
with the identification. 
 
Often a child will already be admitted to another centre.  If this is the case, you will have 
to contact the centre they are enrolled in and ask them to cross-enroll the child to your 
centre.  If so, please go to the section on Cross-enrollment.  If this is the first centre the 
child is being admitted to for the current year, you will want to proceed with the directions 
indicated in this section. 
 
As this child already has a permanent record in BCeSIS, most of their demographic 
information will already have been entered. You only need to update any new 
information: i.e. Address, Admission Reason and Previous Centre. 

 

Procedure  

Path: Start Screen>Admit 
 

1. Perform the restrictive query. The child record appears on the list.  
 

2. Ensure that you have the correct record by selecting the More Information button, 
to view additional identifiable information on the child.   

 

3. When you are sure that you have the correct child record, click the Select button on 
the bottom of the Admit screen.  

 

 
 

The Basic Child Demographics screen will appear in Admit Mode (note the blue bar). 
Note that the child’s withdrawal date appears on the top right hand side of the screen in 
Red highlights.  
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4. Update the record as necessary. Address and Telephone number may require 

updating. 
 

5. Enter the Reason under Admission Information 
 

6. Enter the Previous Centre/District Information if appropriate 
 

7. Save the record.  
 

8. Three separate prompts will display in sequential order;  
 
1. Release of Information? Yes or No depending on the parents wishes 

and centre policy. 
 

 
 

2. Would you like to create an Attendance Registration record? Yes or No. 
Always respond with a Yes. 
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3. Do you wish to assign siblings? Yes or No. Choosing Yes will take you 
to the select Student Siblings screen where you will be required to 
perform a restrictive query to select the child’s siblings. This activity will 
link the children and parents records so that if one is updated you will be 
prompted to automatically update the others.  

 

  
 

1.2 Cross-Enrollment 

Cross-enrolment is an excellent feature of BCeSIS.   If a child is attending more than 
one centre, the first centre that enrolled them may be contacted and asked to cross-
enroll the child to your centre.  Once a child is cross-enrolled to your centre and 
assigned the Early Learning course, that centre can then take attendance on that child 
as well. 
 
Children may be cross-enrolled in more than one centre. 
The first centre to enroll (admit) a child is responsible for processing any cross-
enrollments. 

 
At the new (cross-enrolled) centre, the child appears on the centre roster in blue. 

1.2.1 Process      

Path: Main Menu> Cross-Enrolment> Cross-Enroll Student 
 

1. From the Cross-Enroll Student screen, query the child you wish to cross-
enroll. 

 

2. Click the Add button to begin the process. 
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3. Enter the required fields 
• Cross-Enroled Schools (from the drop down list, choose the 

appropriate StrongStart BC Centre).  
• Adm Date: DD-MMM-YYYY  
• Enroled Reason  

 

 
 
Select Save to save your changes and complete the cross-enrolment. 

 

1.3 Withdrawal 

 

Purpose 
You may need to withdraw a child for a variety of reasons such as the family is moving 
to another school district.   

 
Before a child can be admitted in his/her next StrongStart BC Centre, the current centre 
must withdraw him/her. 
 
The current centre is the centre of record and will retain “ownership” of that child’s record 
until the next centre picks up the record by admitting the child. Once a child is withdrawn 
from the current centre, the history for that child’s record is archived and some reports 
cannot be run. Therefore, it is important to print any reports before the child is 
withdrawn.   
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1.3.1 Withdrawing a student currently registered  

 

Children may withdraw from a centre at anytime throughout the year.  The 
withdrawal date must be on or after the registration date. 

Process 

1. Query for the child on the Start screen. 
 

2. Click the Withdraw icon. 
 

3. Enter the withdrawal date. 
 

4. Enter a withdrawal reason from the dropdown list of values. 
 

 
 

5. Select the Withdraw button.  You will receive a pop up, warning you to print 
all required reports.  Click OK to this warning. 
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2.0 Demographics 

2.1 The Student Basic Demographic Screen 

 
Pathway: Start screen > Basic button 
 
This is the first page of the Demographic Loop.  The data on this page is required when admitting a new child into BCeSIS.  The data 
on this page needs to be updated as appropriate when registering a child already admitted into BCeSIS. 
 
 
 
 
 

  
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

“Previous School/District” is required 
data if the child has attended other 
StrongStart centres in previous years.  
Choose a district and centre by clicking 
on the ? buttons. 

Clicking on the Demo Log button brings up a 
screen that displays all changes made to the data 
on this screen (including who made them and 
when). 

 

PEN’s are automatically populated everyday 
for newly admitted students. If it doesn’t 
populate, that means there is already a 
record for that student in the system.   
 

This advisory button indicates the date that the student was registered (either 
during the Admission Process or when attendance is first taken for the child.)  
The Registration Date may be different from the admit date.   

BCeSIS will automatically generate a 
new pupil number for a newly admitted 
child. 
 

This area is left to the discretion of the 
school to create their own codes and 
meanings. 

 

Incorrectly set Gender can cause 
duplicate PEN’s.  Please ensure that 
the Gender is properly set. 

All bold fields are required before you 
can save. 

Check this box if the student has no 
middle name. 

Tick this box  to cause the property 
address to copy here. 

Follow the Canada Post conventions 
when entering address info. 

 



StrongStart BC Centres Reference Guide 

 

version 1.4.1 Page 16 of 27 26 June 2009 

2.2 Parent Information Screen 

 
 

Pathway: Start Screen > Common View > Family > Parents 
 
The Parent Information screen houses all pertinent parental/guardian information available and relevant for each child.  
Information may include details on a student’s legal parents, step-parents, legal guardians, those who may have court 
access to the student and any individuals who are to receive additional mailings from the school or district. 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Steps: To add a parent, click on the ADD button.  To delete a parent, click on the DEL button.  Enter other information as 
available.   
 
 

 

If custody is set to both parents, you 
must enter the data for both parents. 
To add the new parent or guardian 
information, click on ADD and enter the 
information on that person. 

 
Once you enter Memo information, a 
memo with info you have entered will 
instantly popup whenever you visit the 
Parent screen. This is very useful for 
custody alerts.  

 

Checking a parent as an emergency 
contact displays the parent on the 
Emergency Contact screen.   

If you have information entered in the 
blue Enter Memo area, a message will 
appear stating this fact on the Yellow 
Alert window (depending on district 
setup). 
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2.3 Student Siblings Screen 

 
Pathway: Start Screen > Common View > Family > Siblings 

 
This screen stores all identified siblings of the currently selected child.  Clicking on the ADD button allows you to do a Restrictive 
Query for a sibling and then to associate that sibling with this child. 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Steps:  

1. Click on the ADD button.   
2. Complete a Restrictive Query using the sibling’s last name, birth date and gender.   
3. Select the sibling and then select the sibling relationship. 
4. Press the save icon. 

 

When searching for a sibling, users 
must enter the sibling’s legal last 
name, birth date and gender i.e. the 
user must know who they are 
searching for. 

 

When doing a query, the program 
searches all children/students in your 
district. 

Making a sibling association will cause 
any change in parent information for 
one sibling to prompt for an update to 
the relevant portions of the sibling’s 
record!!! 

 

This Pop up window appears when you 
click on the ADD button.   

 

Please Note! 
Under the System Setup Utilities 
screen there is an option/button to 
Mass Create Siblings.  This screen 
allows districts to generate sibling 
relationships for a specific centre or the 
entire district, based on either home 
phone number or home address. 
Path: Administration>System Set-up 
Utilities 
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2.4 Emergency Contacts 

Pathway: Start screen > Common view > Emergency Contacts 
 
BCeSIS considers Emergency Contacts as “who the school should call in the event of any incident or emergency”.  It does not look at Emergency 
Contacts as “who to call when you can’t reach the parents/guardians” as some districts understand this concept.  That is why this screen stores 
information about parents or guardians taken from the Parent Information screen (if the “Emergency Contacts” box was checked on the Parent 
Information screen) as well as other emergency contacts. 
 
 
 

 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Steps:  

1. Click on the ADD/DEL button to manage emergency contacts. 
2. Change the call sequence as necessary.   
 

* A read only screen with a summary of all Parents and emergency contact information is available through the start screen > commonview > 
Parents/Emergency Contacts. 

If the Auto-Generate Emergency 
Contacts option has been set to yes 
under the Company File>Student 
Demo tab, and the parent has been 
checked as an emergency contact on 
the Parent Information screen, the 
parent will automatically populate and 
have a call sequence of 1. 

Click on the ADD button to add a new 
contact. 

 

The information entered on the Basic 
Student Demographics window 
populates the top section of the 
Emergency Contacts window and can 
be queried. 

Relationship — This drop-down list 
allows you to add the relationship of 
the emergency contact. If “parent” is 
selected, the blue Parent button will 
automatically be activated. 

Records are sorted first by call 
sequence number, then by relationship 
(parents/guardians first) and then by 
alphabetical order. 

 

Call sequence—Use this field to set 
up a call sequence, setting up the 
order in which a person is to be 
contacted in case of an emergency (all 
contacts default to a call sequence of 
1). 

 

BCeSIS does not require any contact information (i.e. phone 
number) beyond the contact’s name before it will save. 
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2.5 Medical Information 

 
 
Pathway: Start screen > Common view > Medical/Health Information 
 

 

This screen allows a Centre to record a child’s health conditions and allergies that need to be tracked.  Alerts can be 
created if certain health conditions/allergies are life threatening (district setting). 
 
 

 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 

Steps: Enter health and medical information as necessary. 
 
 
 
 

There is space for only 250 characters 
in this box, so you need to keep the 
information here concise. 

 

The information entered on the Basic 
Student Demographics window 
populates the top section of the 
Emergency Contacts window and can 
be queried. 

If an allergy or health conditions is 
tagged as life threatening (i.e. “Yes” is 
indicated) then the Medical button on 
the Start screen will turn red (if set as 
an alert by your district).   
The information put into this field will 
cause a Yellow Alert button to display if 
one isn’t already displayed.  Clicking 
on the Yellow Alert button will display 
the text you entered in this field.  You 
must re-query this student for the Alert 
to properly refresh. 

PRN – this means Per Request as 
Necessary, i.e. give medication as 
necessary. 

 

Last Physical Exam information can be 
linked to team and groups. 
 

Information added to this box will not 
signal any alerts in BCeSIS. 

Enter Medical Information here as 
necessary.  
 



StrongStart BC Centres Reference Guide 

 

version 1.4.1 Page 20 of 27 26 June 2009 

3.0 Adding the XAT--EL Course 

Pathway:  BCeSIS Start screen > Courses button 
 
Because Positive Attendance is course-based, children in StrongStart BC Centres need to be assigned a course.  One course is set up in a 
Centre into which all StrongStart children will be placed for the purposes of taking attendance. 
 
Important: Never transfer a StrongStart student to another course as this may cause positive attendance data to be lost. 

 
  
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Steps: 
1. Press F7 to begin a query for a student.  Enter data to query and then press the F8 key.   
2. Click on the Course button.  On the “Look up Course by Course” screen, press the F7 key on your key board and then type in 

the course code XAT--EL.  Press F8 and then click on the Select Current button. 
3. You will return to the Student Course Selections screen. Press the Simulate button. 
4. Press the Save icon. 

Once a student has been assigned a 
course, this line will appear with values 
in every field. 

Once the course has been assigned 
and simulated, click on the Save icon.  
If you have missed a step, the 
program will provide you with an 
appropriate warning. 

To actually schedule this student into 
the XAT--EL course, click on the 
Simulate button.  Once you click on the 
save icon, the student will be confirmed 
in this course. 

Once the course has been selected, it 
will appear on this table with 
incomplete information. 

 

Query for a specific child by pressing 
the F7 key, entering some 
demographic data (i.e. last name) and 
then pressing the F8 button on your 
keyboard.  Use the wildcard symbol % 
to aid your search.   

The Course button allows you to 
choose from the courses available at 
your school.  Click on this button, press 
the F7 key on your key board and then 
type in the course code XAT--EL.  
Press F8 and then click on the Select 
Current button. 
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4.0 Positive Attendance 

Positive attendance allows StrongStart Centres to record the date that a child attended your centre.  To take attendance you must 

click on the attendance icon  and then click ok to the message that you are leaving BCeSIS.  Click OK to the date screen that 

appears and click on the Positive Attendance icon .   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note:  Currently, Facilitators who have been assigned the security class ELC_Attendance may receive the error message “Att 010” 
when entering this screen.  This will not affect functionality.  Simply, press OK and then continue. 
 

 
Click Ok to this popup window.  
The date on this screen is not 
related to that used in positive 
attendance. 

 
Once you click Ok to the 
popup window, this icon will 
become active.  Click on it to 
take positive attendance. 
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Pathway: Start screen > Attendance Icon > Positive Attendance Icon 
 
Many of the fields on the Student Attendance Information table and in the Positive Attendance Reports are not relevant to StrongStart BC Centres.  
The only fields that are important are the child’s name, the date of attendance, and if there is a number greater than zero in the “Current Minutes” 
column.  Once attendance data is entered for a child, it cannot be deleted: If you have entered data erroneously, add a negative value to the 
student’s attendance minutes to create total number of minutes equal to 0 (zero) in the “Current Minutes” column. 

 
   
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
Steps: 

1. Select the Student Attendance Information tab. 
2. Select “Facilitator” from the Teacher drop down list of values. 
3. Choose a student (each student must be chosen individually). 
4. Set the date that you would like to take attendance for.  Defaults to today’s date. 
5. Click on the Change/Add Minutes button. 
6. Select the class, student and appropriate date on this Adding a Modified Record popup window. 
7. Enter a numeric value in the Attendance Minutes field.  Any entry is sufficient to create a record of attendance and produce the 

necessary date stamp for this child (minutes of attendance is not used in Ministry reporting). 
8. Press Save and Exit. 
9. Continue steps 3-7 for each student. 

Click on the Change/Add minutes 
button to take positive attendance.  
The currently selected child will appear 
in Pupil Name field of the Adding a 

Modified Record popup window. 

Click on this tab in order to take 
attendance. 

Set the date that you would like to take 
attendance for.  Defaults to today’s 
date. 

Choose the child you would like to 
take attendance for from the list of 
values next to Students. “All 
Students” is used for viewing all 
students on this table.  It is not used 
for taking attendance. 

Select “Facilitator” from the 
dropdown list of values next to 
Teacher.  Do not select “All 
Teachers”.  Facilitators without 
students will not be visible. 

Ensure that the correct values are in 
the Class, Pupil Name, and Attendance 
Date fields. 

Enter a number in the Attendance 
Minutes field.  A number of “1” will 
suffice to create the record. 

Click on the save and exit icons.  The 
details of the record will display on the 
table. 
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5.0 Positive Attendance Reports 

You can create a positive attendance report based on one student or all students and on one date or a date range.  You can then 
group the attendance data by student name or by attendance dates using the sort by function.  Many of the fields on the Student 
Attendance Information table and in the Positive Attendance Reports are not relevant to StrongStart BC Centres.  The only fields 
that are important are the child’s name and the date of attendance. 
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To print a report for all students for 
today’s date, simply click on the printer 
icon.  Otherwise, choose the 
appropriate date range and student. 

Positive Attendance: Generate a Report tab 
 
Pathway: Start screen > Attendance Icon > Positive Attendance Icon > Generate a Report tab 

 
 
   
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Steps: 

1. Click on the Generate a Report tab. 
2. Optionally, choose how you would like to sort your report by: Teacher, Students, or Date Range. 
3. Optionally, select a date range for this report.  The default is today’s date. 
4. Ensure that the appropriate facilitator has been selected. 
5. Choose to create this report for All Students or only one student by selecting from the dropdown list. 
6. Click on the printer icon. 

 

Typically, StrongStart BC Centres will 
only have one generic facilitator 
available here. 

Click on this tab in order to generate 
a report. 

Optionally, select a date range for 
this report.  The default is today’s 
date. 

Optionally, choose how you would 
like to sort your report by: Teacher, 
Students, or Date Range. 

 

Choose to create this report for All 

Students or only one student. 

Typically, this block will not be used 
in StrongStart BC Centres.  
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6.0 Some Other Useful Reports 

 
BC Student Information Verification Form (CUST036) 
 

04 Demographics > BC Student Information Verification Form  
 

This report potentially can provide a blank intake form for parents to fill in.  Once data has been entered into the system, 
parents can validate the information from a printed copy. 
 

 
 
BC Class Record (CUST057) 
 
 01 Attendance – Daily Method Reporting > BC Class Record 
 
 This report allows a user to produce a list of StrongStart students in rows and an editable group of 10 columns.  In the 

example provided, these have been populated with the days this StrongStart Centre is open. Both registered and non-
registered students display in this report. 
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BC Attendance List by Teacher (CUST062) 
 
 01 Attendance – Daily Method Reporting > BC Attendance List by Teacher  
 
 This report automatically pulls the days configured for this school on the School Details screen.  It allows a user to print all of 

the registered students active in a class in a given week. 
 

  
 
Class Attendance Worksheets (STU820) 
 
 02 Attendance – Period Reporting > Class Attendance Work Sheets 
 
 This report automatically pulls the days configured for this school on the School Details screen in 4 week blocks.  Both 

registered and non-registered students display in this report. 
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